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AKVIS DECORATOR 9.0 | RESURFACE AND RECOLOR

Do you want to make with a click a car in snakeskin or a statue dressed in fine clothes?

With AKVIS Decorator you can create things that were unimaginable even to Mother Nature.

The software lets you change the surface of an object in a realistic manner.

Select a part of an image – a dress on a girl, a car, a piece of furniture, etc, and apply new textures to it. The girl can have
her dress painted in cheerful patterns, dotted or chequered, appear as if made of velvet or satin, or even of wood or candies.

There is a great variety of patterns in the built-in Texture Library, more than 1800 textures, to apply - from fabrics to
stones and metal, from food to nature elements. You can also apply your own texture – just load an image as a texture file
into the library.

The software follows the underlying features of the object, the texture that already exists. The new pattern looks absolutely
natural and makes you see things differently.

Experiment with Decorator to discover its full potential!
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Small changes can make a big difference. Apply different textures to the same image and see how one or the other detail
affects the overall appearance of the image.

With the program you can quickly choose a suitable design for your apartment by playing with different colors and patterns
for furniture, walls, curtains, decorations, etc. It’s useful for designers to show the customers the same room in different
versions, or for web-designers to represent the same items in an online shop (china-ware, blankets, clothes, piece of
furniture, etc) in different colors/patterns. The software improves your efficiency and productivity and highly recommended
for business use.
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By AKVIS tradition, the program has a simple interface, easy grasped even for newbies.

In the Decorator’s window you go to the Texture tab and select a texture from the library (you can adjust its color and
frequency of the pattern), press the Run button and get a wonderful result. If needed, you can adjust the brightness and the
angle of lighting.

If all you need is just to change the color of the surface, then you go to the Color tab and choose a new color. The program
applies a new texture or a color preserving the volume of an object, following its folds and creases.
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AKVIS Decorator is available in two versions - as a standalone program and as a plugin to a photo editor.

The plug-in is compatible with AliveColors, Adobe Photoshop, Photoshop Elements, Corel PaintShop Pro, etc. 
Refer to Consult the compatibility page for more details.
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INSTALLATION ON WINDOWS

Please find instructions below on how to install the AKVIS programs on Windows.

You must have administrator rights to install the program on your computer.

Before installing the AKVIS plugins, please make sure that the image editor where you want to install the plugins, is closed. Or
re-run the image editor after the installation of the plugin.

 

1. Run the setup exe file.
2. Select your language and press the Install button.
3. To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

4. To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

5. Press the Install button.
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6. The installation is in progress.

7. The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-
mail address and confirm that you accept the Privacy Policy.
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8. Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the
desktop, if during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in
Photoshop: Filter -> AKVIS –> Decorator, in AliveColors: Effects -> AKVIS –> Decorator.
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INSTALLATION ON MAC

Follow the instructions to install the AKVIS software on a Mac computer.

You must have administrator rights to install the program on your computer.

 

1. Open the dmg file:

- akvis-decorator-app.dmg to install the Standalone version

- akvis-decorator-plugin.dmg to install the Plugin into your image editor.

2. Read the License Agreement and press Agree, if you agree with the conditions.

3. Finder will open with AKVIS Decorator application or AKVIS Decorator PlugIn inside.

 

4. To install the Standalone version, drag the AKVIS Decorator app into the folder Applications (or any other place you
like).

To install the Plugin, drag the entire AKVIS Decorator PlugIn folder into the Plug-Ins folder of your graphic editor:

AliveColors: You can choose in the Preferences the folder of the plugins.

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC;

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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AKVIS Plugins on Mac
(click to enlarge)

After installation of the plugin, you will see a new item in the filters/effects menu of your photo editor. Select in Photoshop:
Filter -> AKVIS -> Decorator, in AliveColors: Effects -> AKVIS -> Decorator.

Run the standalone application by double-clicking on its icon in Finder.

You can also run the AKVIS programs from the Photos app by choosing the Image -> Edit With command (in High Sierra and
later versions of macOS).
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INSTALLATION ON LINUX

Follow the instructions to install the AKVIS software on a Linux computer.

Note: The AKVIS programs are compatible with Linux kernel 5.0+ 64-bit. You can find out the kernel version using
the uname -srm command.

 

Installation on Debian-based systems:

Note: You need apt-install or apt-get permissions required to install software.

1. Run the terminal.
2. Create a directory to store keys: 

sudo mkdir -p /usr/share/keyrings
3. Download the key that signed the repository: 

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 
or wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null

4. Add the repository to the list where the system looks for packages to install: 
echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-
deb.sfo2.cdn.digitaloceanspaces.com akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list

5. Update the list of known packages: 
sudo apt-get update

6. Install AKVIS Decorator 
sudo apt-get install akvis-decorator

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates, use the command: 
sudo apt-get upgrade

To remove the program: 
sudo apt-get remove akvis-decorator --autoremove

 

Installation on RPM-based systems (CentOS, RHEL, Fedora):

1. Run the terminal.
2. Register the key that signed the repository: 

sudo rpm --import https://akvis.com/akvis.asc
3. Add the repository to the system: 

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo
4. Update the package list:

when using the dnf package manager: 
sudo dnf update

when using the yum package manager: 
sudo yum update

5. Install AKVIS Decorator:

when using the dnf package manager: 
sudo dnf install akvis-decorator

when using the yum package manager: 
sudo yum install akvis-decorator

6. The installation is completed.

Launch the program via the terminal or using the program shortcut.

7. For automatic updates:

when using the dnf package manager: 
sudo dnf upgrade

when using the yum package manager: 
sudo yum upgrade

8. To remove the program:

when using the dnf package manager: 
sudo dnf remove akvis-decorator

when using the yum package manager: 
sudo yum remove akvis-decorator
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Installation on openSUSE.

1. Run the terminal.
2. Login as a root user.
3. Add the key that signed the repository: 

rpm --import http://akvis.com/akvis.asc
4. Add the repository to the system: 

zypper ar -r https://akvis.com/akvis.repo akvis
5. Update the package list: 

zypper ref
6. Install AKVIS Decorator: 

zypper install akvis-decorator
7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates: 
zypper update

To remove the program: 
zypper remove akvis-decorator

 

In order to display the program interface correctly, it is recommended to install the Compton or Picom composite manager.
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AKVIS SOFTWARE ACTIVATION

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS Decorator and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the
number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation
time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types:
Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available
in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet,
for example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (Decorator.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in
Users’ Shared (Public) Documents:

Windows:

C:\Users\Public\Documents\AKVIS

(This PC > Local Disk (C:) > Users > Public > Documents > AKVIS)

Mac:

/Users/Shared/AKVIS

Open the Finder,  se l ec t  the  Go menu,  then se lec t  Go to Folder... (⌘ +Shift+G ) ,  t ype

"/Users/Shared/AKVIS", and click Go.

Linux:

/var/lib/AKVIS

Your registration is completed!
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When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change
Home to Home Deluxe or Business).
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WORKSPACE

AKVIS Decorator can work independently as a standalone program or as a plug-in to a photo editor.

Standalone is an independent program. You can run it in the usual way.

Plugin is an add-on for graphics editors, for example for Photoshop, AliveColors, and other compatible programs. To call
the plugin, select it from filters of your image editing program.

AKVIS Decorator's workspace looks like this:

Most of AKVIS Decorator's workspace is taken by the Image Window with two tabs Original and Processing. All
operations are performed in the Processing tab. You can switch between the windows by left-clicking on the tab with the
mouse button. To compare the original and the resulting images, click on the image and hold the button pressed - the
program will then switch between tabs.

You can select how Image Window and Original/Processing tabs will be shown by adjusting the View Modes in the
bottom part of the left panel.

 

The Control Panel has the following controls:

The button  opens the home page of AKVIS Decorator.

The button  (only in the standalone version) opens the image for processing. The hot-keys are Ctrl+O  on

Windows, ⌘ +O  on Mac.

The button  (only in the standalone version) saves the image to the disk. The hot-keys are Ctrl+S  on Windows,

⌘ +S  on Mac.

The button  (only in the standalone) opens the Print dialog to print the result. The hot-keys are Ctrl+P  on

Windows, ⌘ +P  on Mac.

The button  loads selected areas that have been saved to a file (.decor).

The button  saves selected areas to a separate file in the .decor format.

The button  cancels the last action. If it is pressed multiple times, it will cancel several previous actions. This can

also be activated with the keyboard, by pressing Ctrl+Z  on Windows, ⌘ +Z  on Mac.
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The button  restores an action cancelled by . 

An action can also be restored with the keyboard, by pressing Ctrl+Y  on Windows, ⌘ +Y  on Mac.

The button  initiates image processing with the current settings. The hot-keys are Ctrl+R  on Windows, ⌘ +R  on

Mac.
The button  (only in the plugin version) applies the result to the image and closes the program window of AKVIS

Decorator.
The button  calls information about the program and opens the registration window.

The button  calls the Help files. The hot-key is F1 .

The button  calls the Preferences dialog box for changing the program's options.

The button  opens a window showing the latest news about Decorator.

 

To the left of the Image Window is the Toolbar.

The tools' parameters are shown in the Settings Panel or in a pop-up box after right-clicking in the image window.

 

Navigate and scale the image using the Navigator. In the Navigator you can see the reduced copy of the image. The red
frame shows the part of the image that is now visible in the Image Window; the areas outside the frame will be shaded.
Drag the frame to make other parts of the image visible. To move the frame, bring the cursor inside the frame, press the left
mouse button and, keeping it pressed, move the frame in the Navigator.

Additionally, you can move the image in the Image Window with the scroll bars or by holding down the space bar, then
holding down the left mouse button while moving the mouse. The mouse's scroll wheel can move the image up and down, and
holding Ctrl  (⌘  in Mac) - while using the scroll wheel will move the image left and right. Holding Alt  (Option  in Mac) will

scale the image. Right-click on the scroll bar to activate the quick navigation menu.

Use the slider to scale the image in the Image Window. When you move the slider to the right, the image scale increases.
When you move the slider to the left, the image scale decreases.

You can also change the image scale by entering a new coefficient into the scale field and pressing the button Enter

(Return  in Mac). Frequently used scale coefficients can be found in a drop-down menu.

You can use hot-keys to change the image scale +  and Ctrl++  (⌘ ++  in Mac) to increase the image scale and -  and

Ctrl+-  (⌘ +-  in Mac) to reduce the scale.

 

Under the Navigator is the Settings Panel where you can adjust the texture, its color, the overlay parameters, the light
source on the image.

The button Reset to Default Settings below the settings restores the default values of the parameters.

Under the Settings Panel you can see Hints for the parameters and buttons when you hover over them with the cursor. You
can choose where the hints will be shown or hide them in the program's Preferences.
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IMAGE VIEW MODES: ORIGINAL AND PROCESSING

At the bottom of the Toolbar of AKVIS Decorator, there are three buttons which let you choose how the Image Window
will look like and arrange the Original and Processing tabs.

Click the first button to open a submenu that contains various options for viewing the original and processed images:

- The button  provides the standard image window mode with two tabs: Original and Processing.

- The buttons  and  divide the main window into two parts, vertically or horizontally, respectively. The

original and processed images become partially visible and the tabs are combined to form the whole picture.

With this arrangement, it's possible to drag the splitter changing the aspect ratio between the Original and
Processing parts.

- The buttons  and  split the main window into two parts, vertically or horizontally, as well. However, in

contrast to the previous option, the windows display the same fragment of the image before and after
processing.

Note: Use two windows side by side when you want to see and compare the original and processed versions of an
image fragment on one screen. If you would rather see the final image as a whole, you can choose the standard image
view mode.

The button  swaps the positions of the original image and result when displaying two windows.
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The 3rd button lets you choose the background color of the Image Window. Pressing , , or  changes the

background color to white, gray, or black, while clicking on  opens the Select Color dialog where you can choose a

color of your choice.
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HOW TO USE THE PROGRAM

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program applies a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things
differently.

To resurface or recolor an object on a photo with AKVIS Decorator follow these instructions below:

Step 1. Open an image.

- If you work with the standalone edition:

The dialog box Select File to Open appears if you double-click on the empty workspace of the program or if you
click on the button  on the Control Panel. You can also drag the required image into the workspace of the

program. The Standalone edition of AKVIS Decorator supports JPEG, PNG, BMP, WEBP, and TIFF file formats.

- If you work with the plugin:

Open an image in your photo editor by calling the command File -> Open or using the key combination Ctrl+O

on Windows, ⌘ +O  on Mac.

Then call the AKVIS Decorator plugin in the Filter/Effects menu of the photo editor:

in AliveColors: Effects -> AKVIS -> Decorator; 
in Adobe Photoshop: Filter -> AKVIS -> Decorator; 
in Corel PaintShop Pro: Effects -> Plugins -> AKVIS -> Decorator; 
in Corel Photo-Paint: Effects -> AKVIS -> Decorator.

Step 2. Select an object to apply a texture on. The selection must be precise.

In AKVIS Decorator, you can make/edit the selection with these tools: , , , , , .

The tools' parameters are shown in the Settings Panel or a pop-up box after right-clicking in the image window.

If you work with the Decorator plugin, you can use any selection tool of your photo editor. A selection made in the
graphics editor will be transferred to the plug-in.
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You can save your selection to a .decor file using . It's possible to load the selection with .

Step 3. In Decorator, you can apply a new texture to the selected object or recolor it. Adjust the parameters in the
Settings Panel, in the Texture or Color tab.
Step 4. Press the button  to apply a texture or a color to the selected object. The result will be shown in the

Processing tab. If necessary, continue adjusting parameters, edit the selection or create a new one. Then re-run the
processing.

Step 5. You can put the finishing touches to your image using the Smudge  and History Brush  tools, available

under the Home Deluxe/Business licenses.
Step 6. In the standalone version you can also print your picture with .
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Step 7. Save the processed image.

- If you work with the standalone edition:

Click on the button  to open the Save as dialog box. Enter a name for the file, choose the format (TIFF,

BMP, JPEG, WEBP or PNG) and indicate the target folder.

- If you work with the plugin:

Press the button  to apply the result to the picture.

Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format
and indicate the target folder.
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TOOLS IN AKVIS DECORATOR

The tools in the program are divided into the groups: selection, post-processing, and additional tools. The tools' parameters
are shown in the Settings Panel or in a pop-up box after right-clicking in the image window.

Toolbar

Hint:

Use the buttons /  to undo/redo the operations made with the tools , , , , , , , .

 

Selection Tools:

The Quick Selection tool  selects an object by analyzing colors of neighboring pixels. Draw with this brush over the

image, and the selection expands, automatically finding edges and filling areas.

Size. It's the diameter of the brush. All similar colors will be selected, considering the edges of the objects and
the value of the Tolerance parameter.

Tolerance. When the value of this parameter is increased, more colors are included in the selected area. If it is
set to 0 the brush selects only the areas where it's applied.

Using Quick Selection Tool

 

The standard selection tools are intended for creating geometric shapes and freeform selections.

Rectangular Selection  lets selecting rectangular and square areas. Drag over the area you want to select

with the left mouse button.
Elliptical Selection  lets selecting elliptical or circular areas.

Lasso  allows creating freehand selections. Draw a selection line around an object. When you release the left

mouse button, the contour will be closed, the final point will be connected to the start one.
Polygonal Lasso  lets creating a freehand selection from straight segments. Move the cursor and left-click

on each point, the program will automatically draw a straight line between two points. To close the contour bring
the cursor to the first point or make a double-click in the final point.

Feather (0-250). The parameter lets blurring edges of the selection.

Anti-aliasing. The check-box lets smoothing the jagged edges of the selection. Enable this option before
creating a selection!
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From Center. The check-box lets creating a selection (a rectangle or an ellipse) using a start point, where
the cursor is, as a center. Otherwise, selections are created from a corner.

Style. You can specify a size of a selection:

Normal. The size of a selection is determined by dragging the cursor.

Fixed Size. This option lets you create a selection with exact dimensions (height and width, in
pixels).

Fixed Ratio. The ratio of height and width of a selection remains fixed.

Using Rectangular Selection

 

Use the following tools options to adjust the selection:

Selection Mode defines the result of the interaction of selections:

New . When creating a new selection, the previous selection disappears.

Add . The selection area will be increased by adding new fragments. The mode is activated by holding

the Ctrl  key.

Subtract . This mode lets removing the part of the selection. The mode is activated by holding the Alt

key.
Intersect . This mode lets keeping only the intersection area of the selections.

Click on  and choose a command (what you want to do with the selection): Invert Selection (Ctrl+I )

or Deselect (Ctrl+D ).

 

The button  activates the Eraser tool to edit a selection.

 

Post-Processing Tools:

Smudge  (Home Deluxe/Business). The tool is used to manually refine the image by removing paint and texture

irregularities.

The tool's parameters:

Size (1-300). Diameter of the tool.

Hardness (0-100). The amount of blurriness of the outer edge. The higher the value, the harder the brush edge
is.

Strength (1-100). The intensity of smearing the paint in the brush stroke. The higher the value, the more color is
smeared.
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Before Using the Smudge Tool Using the Smudge Tool

Before Using the History Brush After Using the History Brush

History Brush  (Home Deluxe/Business). The tool partially or fully restores the area to its original state.

The tool's parameters:

Size (1-1000). The maximum width of a line drawn with the brush.

Hardness (0-100). The blurriness of the tool's edges. The less the value the more blurry the tool's edges
become. At value 100% the border between the brush's edges and the background is very distinct; at lower
values the transition between these areas is smoother.

Strength (1-100). The degree of restoration to the original state. At lower values there will be less restoration
and more blending with the effect; at values near 100% the original condition will be restored more completely.

 

Additional Tools (available on both tabs, for all licenses):

Hand  lets you scroll the image when it does not fit within Image Window at the desired scale. To use it click on

the button, bring the cursor over the image, and while keeping the left mouse button pressed move in the desired
direction. The hot-key is H .

Double-clicking on the tool’s icon   on the Toolbar makes the image fit the window.
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Zoom  lets you change the image’s scale. To zoom in left click on the image. To zoom out left click with Alt  on the

image. The hot-key is Z .

Double-clicking on the tool’s icon   makes the image scale to 100% (actual size).

Crop  (in the standalone version). The tool lets you cut off unwanted areas in the image. The tool is useful when

you want to improve the image composition, straighten a crooked photo, turn a horizontal photo into a vertical one and
contrariwise.

Note: This tool is applied to the original image! Use it before the effect.

You can change the crop area by dragging the sides and the angles of the bounding frame.

Use the buttons in the Settings Panel to control the tool:

To apply the result and remove the areas outside the frame, press OK or use Enter . To cancel the operation and exit

the tool, press Cancel or use the Esc -key. To restore the original area keeping the tool active, press Reset button.

Crop Image

Adjust the crop parameters:

You can choose the size of the crop rectangle using the Ratio or Fixed Size options.

If the External Area check-box is enabled, you can change the color and opacity of the outer parts.
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RESURFACING

You can apply a new texture to a selected object. Adjust the parameters in the Settings Panel in the Texture tab.

Texture Library

AKVIS Decorator includes the built-in Texture Library with a great variety of patterns. To open the Library, double-click on
the square with a texture sample. All textures in the program are divided into groups: stone, fabric, flowers, etc. Choose a
group from the tree and then select a texture with a double click.

User Textures

You can also use your own textures in AKVIS Decorator.

To load an image as a texture into the program for a one-time use, open the Library, press  and select your texture.

It's also possible to specify a user texture folder. Switch from the Library to My Textures and select a folder with your
images.

To come back to the Settings Panel without selecting a texture, click on .
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Adjust the texture settings:

Angle (-180 to 180). This parameter sets the rotation angle of the texture. A negative value rotates the texture
counterclockwise, a positive one - clockwise.

Angle = 0 Angle = -45 Angle = -90

Scale (10-200%). This parameter sets the scale of the pattern. By default, the scale is 100%. If you reduce the value
of the parameter, the pattern size on the texture gets smaller, if you increase the value of the parameter, the pattern
takes more space on the texture.

Scale = 50 Scale = 100 Scale = 155

Colorize. This option allows you to change the color of the chosen texture. Click on the plate to activate the
eyedropper tool, double-click to open the Select Color dialog.

Adjust the degree of color mixing by moving the slider. At the value = 0 the original colors are used.
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Brightness = 70

 

Brightness = 120

 

Deepness = 5

 

Deepness = 35

 

Warping = 10

 

Warping = 90

Original color Blue color Rosy color

Adjust the parameters that influence the way the texture is applied to the object:

Brightness (10-200). This parameter lets you lighten or darken the selected area. The default value is 100. The higher
the value, the brighter the image is.

Deepness (0-100). This parameter influences the amount of light and shade on an image. At 0, shades, folds and
gradients are ignored; as a result the object looks flat. The higher the parameter, the more pronounced highlights and
shades become, and the image looks deeper. However, if the value of the parameter is too high, some parts can
become overexposed or underexposed.

Warping (0-100). This parameter sets the level of the texture warping. At 0, the texture is not warped at all, the
higher the parameter, the more deformed the texture is.

Light Source. Use the dagger on the ball to set the probable light source when the photo was taken. The position of
the light source influences the texture wrapping.

Сlick the Reset to Default Settings button to restore the original settings.

 

AKVIS Decorator

30



RECOLORING

You can recolor the selected object. Adjust the parameters in the Settings Panel in the Color tab.

You can select a color from the Color Palette or from the Select Color dialog box. To select a color from the Color Palette
just left-click on any color of the palette. The selected color will be shown in the color rectangular on the right.

Click on the color rectangle to activate the eyedropper tool, double click to open the selection color dialog.

In the Color tab there is also a mini-palette (empty cells) where you can keep custom colors. To save a color in the mini-
palette, just drag this color from the color rectangle on any cell of the palette (even if the cell is not free). To select a color
from the mini-palette, just left-click it with the mouse. To remove a color, right-click it.

 

Adjust the parameters that influence the way the color is applied to the object:

Brightness (10-200). This parameter lets you lighten or darken the selected area. The default value is 100. The higher
the value, the brighter the image is.
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Brightness = 60 Brightness = 140

Deepness (0-100). This parameter influences the amount of light and shade on an image. At 0, shades, folds and
gradients are ignored; as a result the object looks flat. The higher the parameter, the more pronounced highlights and
shades become, and the image looks deeper. However, if the value of the parameter is too high, some parts can
become overexposed or underexposed.

Deepness = 5 Deepness = 40

Сlick the Reset to Default Settings button to restore the original settings.
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PREFERENCES

Open the Preferences dialog by pressing on . The window looks like this:

Language. To switch the interface language, select another language from the drop down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
Initial Scale. This parameter affects how the image will appear in the program when you first open it. The parameter
can have one of two values:

- If the parameter is set to Fit to View, the image will be scaled so that it will fit completely within the Image
Window;

- If the parameter is set to 100% the image will not be scaled. In most cases, when an image is opened at
100% scale the entire image will not fit within the Image Window.

Recent Files (available only in the standalone version). The number of recent documents. The list of the recent files,
sorted by time, become visible by right mouse clicking on . Maximum: 30 files.

Selection Area. This parameter defines how the selection appears. Please choose one of two variants:

- "Marching ants". The selection is enclosed in borders that look like a "running" dotted line. This is the default
value.

- Filled with color. The selection will be filled with a color.

By default the Color is red but you can change it. Just double-click on the color plate and select a color
from the Select Color dialog.

The Opacity parameter allows you to adjust the opacity of the color used to highlight the selection.

Hints Panel. You can choose how the hints will be shown:

- Under Settings Panel;
- Under Image Window;
- Hide.

Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the check-box is enabled
the panel is always visible. Uncheck the option to unlock the panel, and you will be able to hide/show it by clicking on
the small triangle button (in the middle of the panel). The minimized panel will be shown when moving the cursor over it.

To apply changes made in the Preferences window press ОК.

If necessary, you can return to the default settings by pressing Default.
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PRINT IMAGES IN AKVIS DECORATOR

In the standalone version of AKVIS Decorator you can print the image. Press the button  to open the Print options.

Print Options in AKVIS Decorator

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the
print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These
parameters have no effect on the image itself, just on the print version. You can change the size of the printed image
by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the
image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a
large picture.

Print Poster

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the
program will automatically select the optimal number of the pages in accordance with the actual size of the image
(scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins
will be added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be
printed in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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TEAPOTS FOR EVERY TASTE

One and the same teapot can look absolutely different if you change its material (color and texture) with AKVIS Decorator.

Original image Results

Step 1. First of all we take a photo of a teapot. It is better to use a teapot without a pattern.

Step 2. Open the photo in any photo editor compatible with AKVIS Decorator.
Step 3. Select the teapot's body (without the handle) using any selection tool. The main thing is that it was
comfortable for you to use this selection tool to draw a precise outline.

You can make/edit the selection in AKVIS Decorator.

Step 4. Call the plug-in AKVIS Decorator and select a suitable texture from the Texture Library. We've chosen a
texture with cheese.
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Step 5. Press the button .

In a few seconds we see a "cheese" teapot in the Processing tab and imagination carries us away to a cosy chalet
somewhere in the Alps where one can taste a cheese fondu and enjoy fragrant tea.

Step 6. We can also choose a different texture, for example, dark-gray paper with a crimped pattern. Press the button 
.
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Step 7. The original color of the teapot is light, therefore even if we apply a dark texture we get only a light version of
it. To correct it we should reduce the value of the parameter Brightness.

Every time you adjust the "overlay" parameters, you should press the button  to apply the changes and see the

result in the Processing tab of the Image Window.

Step 8. To make the new texture look more natural, we can increase the value of the parameter Deepness. Thus, the
distribution of light and shade becomes more pronounced - the dark areas get darker, the light areas get lighter.

The photo has been taken with the built-in flash gun, so the light falls directly on the subject. We do not need to
change the position of the light source on the ball.
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Step 9. Apply the result by pressing the button . The simple pattern and muted color remind one of the formal

oriental tea ceremony.

Click the pictire to see this teapot for the tea ceremony in a larger window

Note: If the selection was not precise or the object's borders were not sharp enough to draw a precise outline, you can
touch-up the borders with a blur tool of a small size after using AKVIS Decorator. For example, you can apply Blur tool 

with Radius = 1.5.
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REPAINTING ANIMALS

The author of this example is Alvaro Salazar Chacon. It was done with the AKVIS Decorator plug-in in AliveColors.

Where nature has chosen modesty and restraint, man sometimes chooses bold experimentation. The AKVIS Decorator plug-
in can change the texture of an animal's skin, concealing it under that of another animal, or giving our friend a playful color.

 

Step 1. Choose an animal photo and open it in the graphics editor.

Original Image

Step 2. Highlight the parts of the body on which the texture will be changed. The New Shape (Freeform) tool  is

useful for this, since its ability to make precise selections can prevent errors.

Marking Edges

Step 3. Once the object has been highlighted completely, right-click and choose Rasterize Layer, then Add Alpha
Channel to Selection from the shortcut menu.
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Making a Selection

Step 4. Call the AKVIS Decorator plug-in. In AliveColors do this by choosing Effects -> AKVIS -> Decorator.

The texture library has many textures which can be used for camouflage - for example, to cover the elephant's skin in
fish scales.

Step 5. Press the  button to start the texture mapping process.

Texture Mapping

Step 6. If you are satified with the result, press the  button. Some examples of using Decorator to apply various

colors are shown below.
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INTERIOR DESIGN

AKVIS Decorator will help you to choose a suitable interior design for your apartment. You can experiment with the furniture
upholstery, with the color of carpets and walls, change the material of the furniture. The changes will take place only on a
photo, at the same time the program will also require no more than a digital image.

Click the pictire to see a variety of interior designs for the kitchen in a larger window

Step 1. Open the photo in your photo editor (we use AliveColors). We've chosen a photo of a kitchen. We will try
different textures for the front of the bar.

Step 2. Select the doors of the bar.
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Step 3. Call the plug-in AKVIS Decorator: Effects -> AKVIS -> Decorator.
Step 4. Select a texture from the Texture Library.
Step 5. Press the button  and see the doors of the bar in a new design.

Step 6. Apply the result by pressing the button .

Step 7. Take the original photo once again and start the plug-in AKVIS Decorator. Select a different texture and press
the button . This time we have a dark texture.
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Step 8. The original color of the bar is light. If we want to get a darker color we should reduce the value of the
parameter Brightness.

Step 9. If after applying a texture the carving on the bar became less visible, you should increase the value of the
parameter Deepness.
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Step 10. Apply the result by pressing the button .

If you continue, you can get a variety of interior designs for the kitchen.
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COLOR AND TEXTURE OF CLOTHES

Change the color of a blouse, turn a one-color dress into a lovely spotted piece of clothing, change the material of a suit (its
color and texture) - all is possible with AKVIS Decorator.

Original Image Result

Step 1. Open the photo in your photo editor.

Note: This tutorial is created with the Decorator plugin in AliveColors, but you can do the same in the
standalone version of AKVIS Decorator.

This girl likes to change clothes. We will help her to try a new dress.

Step 2. Call the AKVIS Decorator plug-in: Effects -> AKVIS -> Decorator.
Step 3. Select the dress of the girl using any selection tool.
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Step 4. First of all choose a suitable texture from the Texture Library. For this purpose open the Library with a
double click of the left mouse button on the square with a texture. We open the Fabric group and choose a pattern.

Step 5. Press the button  to apply the chosen texture to the dress with the default settings.

In a few seconds you will see the result in the Processing tab.

We can give the picture a natural look by changing parameter Warping = 25.

Press the button  again.
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Step 6. Apply the result by pressing the button . The plug-in's window will close and we will see the girl in a new

attire.
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool
that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using
chosen settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the
quality of compressed images. This program provides 4 image enhancement modes, each involves a unique neural network
developed especially for this occasion. The software is available free of charge for home users. For commercial use, a
Business license is offered. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different artistic techniques: Oil Painting, Watercolor,
Gouache, Comics, Pen & Ink, Linocut, Stencil, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any
picture! More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is
very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…
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AKVIS Charcoal — Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can
make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding
artistic effects, such as sanguine and others. More…

 

AKVIS Coloriage AI — Add Color to Black and White Photos

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color images, performing selective colorization and
desaturation. It helps to breathe new life into your old family photographs, bring a vintage or artistic appearance to your
digital images. More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things
differently. Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a
photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve
Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to
a picture, it lets you improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies
dust and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The
program can also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS Inspire AI — Artistic Stylization of Images

AKVIS Inspire AI stylizes images using various samples of painting. The AI-based program applies the color scheme and style
of a selected artwork to a photo creating a new masterpiece. The software includes a gallery of art styles and allows to load
a custom sample. Imitate the style of world famous artists! More…
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AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting
techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little
magic to your pictures! More…

 

AKVIS Magnifier AI — Enlarge Images & Enhance Quality

AKVIS Magnifier AI allows you to increase the size of photos and improve image quality and appearance. Featuring neural
network-based algorithms, Magnifier AI upscales images to super-high resolution, up to 800%, and produces wall-sized prints.
Improve image resolution, create clear, detailed images with perfect quality! More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making
your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look
your best in every photo with AKVIS MakeUp! More…
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AKVIS NatureArt — Bring Nature to Your Photos

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program
includes a number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…
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AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing
any type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software
includes AI technologies and adjustments for manual refining. More…

 

AKVIS OilPaint — Oil Painting Effect

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes.
The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can
become a painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one
of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…
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AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism.
With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors!
More…

 

AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating
a selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five
image processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using
the information of the surrounding areas. More…
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AKVIS Sketch — Turn Your Photos into Pencil Sketches

AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W
sketches, imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles:
Classic, Artistic, Maestro, and Multistyle, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist!
More…

 

AKVIS SmartMask — Save Time on Complex Selections!

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The
software considerably increases your productivity. You will be freed from boring work and will have more room for creativity
and realization of your ideas. More…
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AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The program includes two styles
of photo to painting conversion: Classic Watercolor and Contour Watercolor; each comes with a wide range of ready-to-use
presets. The software turns ordinary images into aquarelle pieces of art. More…
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